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Getting Started 

Introduction  
Welcome to Polygon AI! From our humble origins as Pipsqueak, 
which started out as a Fiji/ImageJ plugin (Slaker et al, 2016), we 
are now proud to offer our own intuitive user interface with 
expanded capabilities and custom AI model training. Polygon AI 
offers unlimited potential to expand functionality to suit our 
users’ diverse image analysis needs. Our software exists to 
remove tedious roadblocks when analyzing large amounts of 
microscopy data. Polygon is an elevated form of Pipsqueak, with 
new features, streamlined login and registration, and a free 
license option to align with our founding mission to improve 
image analysis for all. 
 
While we transition from Pipsqueak to Polygon, your license will 
work the same in any version, and your experiments and custom 
models will be transferred from Pipsqueak to Polygon. Most importantly, the core analysis methods and 
algorithms remain the same so you don’t need to worry about transferring mid-experiment.  
 
Thanks for trying the new Polygon AI! We encourage you to report bugs or provide suggestions within the app 
via the bug report form. We’d also love to hear suggestions for future features that matter to you and your lab! 

Installation 
To use Polygon AI, new users will first need to download the software from our website. Existing Pipsqueak users 
can upgrade within the Pipsqueak app from the prompt that will appear whenever you open Pipsqueak. Unlike 
our original “PIPSQUEAK” software, Polygon AI does NOT require installation of Fiji/ImageJ.  
 
Windows 
For Windows users, run the downloaded .exe file and Polygon AI will automatically install and open. It will also 
appear as a start menu app in a Rewire folder. Polygon AI is compatible with Windows 10 or newer OS. If you 
receive a “Windows Protected your PC” message when installing Polygon AI, you’ll need to select “More Info” 
and “Run Anyway”.   
 
Mac 
Double-click the downloaded Polygon AI .dmg file and a Finder window will open. In that window, drag and drop 
the Polygon AI icon into the Applications folder. From there you can open Polygon AI from Launchpad or from 
spotlight search. Polygon AI is compatible with MacOS High Sierra (10.13) or newer. 
 
First Time Startup (Windows & Mac) 
When Polygon AI is starting for the first time it can take a few minutes to download extra resources and updates 
in the background, so don’t close the window until this process is finished. You will know it’s finished when the 
splash screen disappears, and the application appears with the Sign-in window.  

Registration and Login 
New Users  
You will need to register a new account within Polygon AI the first time you use the software. Your licence is tied 
to your registration email. A given account can be used on multiple computers but can only be used by one 
person at a time.  
 
Existing Pipsqueak Users 

https://scholar.google.com/scholar?q=A+standardized+and+automated+method+of+perineuronal+net+analysis+using+Wisteria+floribunda+agglutinin+staining+intensity&hl=en&as_sdt=0&as_vis=1&oi=scholart
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If you’ve already used Pipsqueak in the past, then the same login information will work in Polygon AI and you do 
not need to register again. New users will automatically start with the Free license and existing Pipsqueak users 
will roll over their existing license type. See Account and License section for more information. 
 

Analysis Workflow 

Starting a New Project 
When starting a new project, set up a unique project name and a description of the project to remind you of the 
details of your experiment. You’ll also be prompted to select the data fields for the final .csv file export. To 
modify these later, right-click the project name in the projects list and select Set Export Options. See the Analysis 
Results Output section for more information on export options. 

Importing Images 
Importing Files or Folders  
You can import selected image files or a whole experiment folder (max 500 MB file size per image). In a folder 
with mixed file types, only images will be imported. Import may take several minutes if you are uploading large 
images or a folder with many images, and the progress bar will indicate the number of files remaining to be 
imported. Note: if a full-sized image file exceeds our 500 MB import limit, you’ll need to manually split it in 
another editing software like ImageJ before importing into Polygon.  
 
Organizing Folders 
When importing folders with subfolders, the organization within the folder will be preserved in Polygon. Folders 
can also be manually added below the project to group an experiment's images. For example, images from test 
subjects and control subjects can be placed in separate folders below the project. Subfolders can be added to 
further separate images. For instance, the test and control folders could have subfolders for images from male 
and female subjects. The appropriate folder setup will allow data to be conveniently grouped when exported for 
further analysis. 
 
Supported File Types  
Polygon can import most standard image types such as .tiff, .png, and .jpg. We recommend using the highest 
quality images possible (such as .tiff instead of .jpg) and keep image size and format consistent within an 
experiment. A mix of file types or compression levels may negatively impact detection model performance.  
 
Stack Import  
It is possible to upload several image files at once as a stack for 3D analysis. You can also import as a summed or 
max projection image for 2D analysis and colocalization. Within the Import Stack window, you can choose 
between Step Selection or Pattern Selection. In Step Selection, set the starting file and file increment to import 
only a subset of images in the folder. This is helpful when importing multi-channel images where several 
channels are present in the same experiment folder and alternate in a repeating pattern within the folder. 
Leaving the default settings of 0 for start index and 1 for step index will import every image file in the folder as 
one stack, whereas a start index and step size of 3 would start with the 3rd file in the folder and import every 3rd 
file after. Pattern Selection offers more flexible sorting, including using keywords to designate which files to 
import. This is helpful when files are disorganized in the folder.  
 
Splitting Large Images  
It is possible to split large images into smaller subsections within Polygon for easier analysis and/or improved 
cell/target detection. This can be done by right-clicking an imported image in the file-tree and selecting Split 
Images. From here you can designate the number of columns and rows to divide the image into. Subsections will 
be placed into a new folder within the project.  
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Image splitting can also be performed during cell/target detection without creating new image subsection files 
(see Image Split below). This option can also improve cell detection in large images and can be found in the 
Analysis panel (top tab on the far right).  

Using Detection Models 
Pre-trained Detection Models  
We provide several pre-trained AI detection models for a wide variety of biomarker types. See our website 
Help/FAQ page for more information about each. Try different models to see which works best for your images, 
use the Recommend Model function (see more below), or create your own custom detection model using our 
intuitive in-app training process. 
 
After choosing a model from the list, click the Detect Cells button. This tells the selected model to scan the active 
image to identify regions of interest (ROIs) based on what it is trained to detect. If none of the results look as 
expected, try modifying the detection settings. 
 
Recommend Model  
If you’re unsure which model to start with, select an image(s) in your file tree and try our Recommend Model 
feature in the model drop-down list. This feature will run your selected image(s) through automated detection 
by our 6 core Rewire models and produce ROIs for you to view which works best on your images.  
 
One or more images of the same type can be selected for model recommendation. Selecting more than one 
image will improve the recommendation quality. To select multiple images, press Shift or Control (Command on 
MacOS) and select images in the Project panel. Then, right-click on the highlighted image names and select 
Recommend Model.  
 
Alternatively, check out the Custom Model Training tutorial in Polygon to get started training your own model.  
 
Object Detection versus Segmentation Models  
Many of our pre-trained detection models are “object detection” models, which are especially good for 
detecting and counting objects with high-background or poorly defined edges. New in Polygon AI are 
“segmentation models” that can provide more detailed morphological information. We currently provide a 
General Segmentation model but will soon add segmentation versions of many of our core models. You can also 
train a custom segmentation model using our new mask tool under the polygon ROI drawing tool in the image 
window.  

Annotating Images 
Image Zoom, Scroll, and Pan 
You can use the “four-arrows” button in the top left above the image to expand the image to the full center 
window size or set a specific zoom level using the number box. To zoom in and out within an image, use Ctrl or 
Command click with the mouse scroll wheel. You can also use Ctrl+click and move the mouse to pan around the 
image.  
 
Placing ROIs  
A Region of Interest (ROI) is a boundary around an object of interest (e.g. an individual cell, microorganism, 
subcellular puncta, or whatever discrete objects you are interested in identifying and quantifying in your 
images). Marking these objects with one of our ROI tools (boxes, circles/ovals, or polygons) is the basis for what 
regions of the image will be included in the Analysis Results output as well as important for telling the computer 
what it is looking for when training a custom detection model.  
 
Changing ROI Shape and Color  
You can change the default ROI color and shape under File > Preferences (Polygon> Settings on MacOS). 

https://rewire.ai/help/
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Manipulating ROIs  
You can move, delete, resize, and copy and paste individual ROIs. See the Hotkeys section or Help > Hotkeys in 
the Polygon AI app for further details. The Select tool allows you to draw around a region to select multiple ROIs 
at a time to delete them as a group. This is also useful to designate subsets of ROIs to modify with the ROI 
Filtering options. You can also hide or show your ROIs for ease of seeing your objects of interest in the image. 
Hiding ROIs does not exclude them from the Analysis Results output (delete an ROI to exclude it from Analysis 
Results output).  

Detection Settings  
Detection Sensitivity  
Adjust this to change the detection sensitivity of the model. This will change the number of ROIs detected in the 
image based on the model’s confidence in its decision. The slider’s number represents the minimum “certainty” 
accepted, with a lower value representing a higher confidence level, meaning fewer ROIs will be detected but 
the probability of false negatives (i.e. missed cells that you’ll need to manually add) will be greater. A higher 
Detection Sensitivity setting, on the other hand, will return less certain results, meaning more ROI boxes will 
appear with a higher probability of false positives that will need to be manually deleted. When first identifying a 
model that works best for your images, you’ll need to play around with the Detection Sensitivity until you find a 
balance where you have the most accurate detection. High Sensitivity settings are often used well in conjunction 
with higher Overlap Removal settings (see below). 
 
Overlap Removal 
This setting will change the amount of overlap allowed between two ROIs. A lower value will allow more overlap 
between ROIs to occur, which can help when cells are closely nested together. A higher value will merge ROIs 
that are overlapping, which helps with false positives detected near an isolated cell. In general, if there are many 
ROIs overlapping, increasing the removal setting can help. 
 
Image Split  
Splitting larger images into smaller pieces during detection can often improve results. This may help if your cells 
are a dramatically smaller size than those that were used to train the original model, due to different zoom 
levels and resolutions. To cut images into smaller files for annotation, use the Split Images option in the right-
click menu in the file tree (see Splitting Large Images above).  
 
Background Subtraction  
The multi-faceted background subtraction in Polygon AI is designed to be highly customizable since many 
different methods are used to capture images from lab to lab. Our automatic background subtraction algorithm 
combines the Rolling Ball algorithm, native to ImageJ, with custom thresholding. Removing background may 
improve detection overall but risks the loss of faint ROIs. We recommend adjusting this consistently across 
images within an experiment.  
 
Begin background subtraction by clicking the checkmark box to the left of Background Subtraction in the 
Analysis panel on the right side of the app. We offer both automatic and manual selection for background 
sampling. Automatic background sampling is used by default. This method places 22 square ROIs around the 
perimeter of the image, distributed uniformly.  
 
If manual sampling is preferred, a user can edit or place their own ROIs for background sampling. Background 
ROI positions can be edited by clicking Set under the Background ROIs title. Adjust, delete, or draw your own 
ROIs as needed (boxes, circles, or polygons are acceptable), then press Save. It is recommended that at least 5 
ROIs are placed, but the algorithm will still perform if fewer are placed. These ROIs are not counted in your data 
export and will not appear on your image after saving them. Background subtraction will remain enabled for this 
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image as long as the blue checkmark is visible. 
 
After background ROIs are saved, the Rolling Ball algorithm smoothing is performed across the entire image. The 
ball’s radius is set to 50 pixels by default, but it is highly recommended that the user changes this to be around 
1.15-1.25 times the average size of the object of interest, in pixels, for best results. Learn more about the 
Rolling Ball algorithm here. 
 
We calculate background subtraction from the mean pixel intensity of the Background ROIs and then discard the 
brightest 33% and dimmest 33%  from the sample. We then calculate the mean pixel intensity and standard 
deviation across the remaining Background ROIs. These values are then used to set all pixels dimmer than the 
calculated mean + two standard deviations to be “Not a Number” (NaN). This results in the suppressed 
background pixels being excluded from the measured cell intensity values within the ROIs. This background 
value can also be subtracted from the Mean Intensity value to calculate the Mean-Background value of pixels 
above background (i.e., the resulting Mean-Background pixel intensities represent signal rather than the mean 
of signal + background). Our background method has been previously published here. 
 
Approve ROIs 
After final annotation of all objects of interest in an image, select the Approve ROIs button (looks like a 
checkmark in a box) below the Detect Cells button. This will show a checkmark next to that image file in the 
Project’s file tree and allow you to keep track of which images you’ve finished. Clicking the Approve button 
followed by Export Results will include the current image’s results in your Analysis Results output. Note: 
approval of ROIs is also necessary to make the image available for Custom Model Training.  
 
Export Results 
Save your results for further analysis outside of Polygon by clicking the Export Results button (looks like an “up” 
arrow) directly below the Detect Cells button in the Analysis panel. This process will create the following Analysis 
Results output files and save them in the selected destination folder: 
 
○ [image_name]_analysis_export.csv   A .csv file with the detailed data for each image that can be opened in a 

wide variety of statistical programs.    
○ [image_name]_user_rois.zip    A .zip file containing the placement of ROIs in a format that can be imported 

into ImageJ or back into Polygon via the Import button 
 
Successful Export will briefly show a popup notification with a link to the file save location. See the Analysis 
Results Output section below for more information. 
 
Multiple results from multiple images can be batch exported into a single Analysis Results output file by right-
clicking on the Project name, folder name, or multiple highlighted image files, then selecting Export Results. This 
will include all approved image data in one .csv file in addition to individual image files. 
 
Import ROIs 
Users can import an externally generated ROI set saved in ImageJ format or re-import ROIs generated, 
approved, and exported during previous Polygon analyses (most likely from the same image file). To use this 
feature, select the Import ROIs button (looks like a “down” arrow) in the analysis panel, select the file with the 
ROIs ready to be imported, and click “Import.” 

Analysis Results Output 
Setting Analysis Results Output 

When first creating a new project you’ll be prompted to set which types of data to export in the Analysis Result 

output file for that image set. You can modify this at any time by right-clicking on the project folder and 

https://imagej.net/plugins/rolling-ball-background-subtraction
https://www.sciencedirect.com/science/article/pii/S2451830116300139
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selecting Set Export Options. 

 
“Legacy” versions of most export parameters are available in the Export Options window to enable data 
replication of cited results. "Legacy” designation in the output files references an older algorithm for that metric 
(as opposed to our “non-legacy" versions). Newer “non-legacy” versions use ImageJ’s method for calculating 
that variable. In all cases, the “Legacy” and “non-legacy” results are very similar, but not identical. We 
recommend using the “non-legacy” versions.  
 
Output Parameter Descriptions  
Below you can find definitions for all output that can be included in your analysis results export. 
 

Image Index 
Ascending sequential numbering of images included in the Analysis Results output file. Used to help sort 
rows during post-Polygon statistical analysis. 
 
Cell Number 
Ascending sequential numbering of ROIs included in the Analysis Results output file. Number is not unique 
to that Image Index. Used to help sort rows during post-Polygon statistical analysis. 
 
ROI ID 
Numeric identifier of the Detection Model or manual annotation that generated the ROI/contour. This 
number is a unique numeric identifier of an ROI that is generated from a Detection Model and ROI 
combination, thus useful for finding a unique cell across channels in a multiplexed image. The first three 
digits are specific to a Detection Model (e.g. “001”) or manual annotation (“FFF”). However, ROI ID numbers 
will be repeated between two images using the same Detection Model (i.e., the ROI ID of the third cell of 
two images analyzed using the “WFA” Detection Model will both be “001-003.”) 
 
Layer 
Z-Stack specific data export. Numerical identifier of the z-step on which the ROI is located. Note that ROI IDs 
are repeated between layers and do not correspond to ROIs on adjacent layers (i.e., the ROI ID number is 
random). See “In Sets” variable below for determining colocalization of ROIs and association with a common 
cell/biomarker in Z-Stacks. 
 
In Set 
Z-Stack specific data export. Numerical identifier of family of ROI colocalizing in the z-dimension around a 
common cell or biomarker. All ROIs given a particular In Set number (e.g., “5”), are associated with a single 
cell/biomarker across multiple Layers (or z-steps) of the z-stack. Note that ROI IDs between layers are 
random and do not indicate colocalization or association.  
 
ROI Source 
Name of the Detection Model (or “hand-drawn” manual annotation) that generated the ROI/contour.  
 
CoM X and CoM Y 
Brightness-weighted average of the x and y coordinates of all pixels in the image or selection. These 
coordinates are the first order spatial moments. Center of Mass (CoM) on the X and Y axis is an ImageJ-
based calculation called “Center of Mass” and uses the XM and YM headings. 
 
Pixel Area 
Area of selection in square pixels. Area is in calibrated units, such as square millimeters, if Image Analysis 
Settings > Unit Scale was used to spatially calibrate the image. Pixel Area does not include pixels set to NaN. 

https://imagej.nih.gov/ij/docs/menus/analyze.html#set
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Pixel Area is also an ImageJ-based calculation called “Area.” 
 

Background 
We calculate background from the mean pixel intensity of the Background ROIs and then by discarding the 
brightest 33% and dimmest 33% Background ROIs from the sample. We then calculate the mean pixel 
intensity and standard deviation across the remaining Background ROIs. These values are then used to set all 
pixels that are dimmer than the calculated mean+ two standard deviations to be “Not a Number” (NaN). This 
results in the suppressed background pixels being excluded from the measured cell intensity values within 
the ROIs. This background value can also be subtracted from the Mean Intensity value to calculate the 
Mean-Background value of pixels above background (i.e., the resulting Mean-Background pixel intensities 
represent signal rather than the mean of signal+background). Our background method has been previously 
published here. 
 
Mean Intensity 
Mean intensity is also an ImageJ-based calculation called “Mean Gray Value.” It is the average intensity of 
pixel values within an ROI (sum/ number of pixels). These pixel intensities are influenced by the Rolling Ball 
subtraction step and Background thresholding to NaN. In other words, the mean value ignores background 
pixels. These values are arbitrary units. 
 
Median Intensity and Mode Intensity 
Median: The median value of the pixels in the image or selection. Mode: Most frequently occurring gray 
value within the selection. Corresponds to the highest peak in the histogram. Median and Mode are also 
ImageJ-based calculations. 
 
Stdev 
Standard deviation of the gray values used to generate the mean gray value. Stdev is also an ImageJ-based 
calculation called “Standard Deviation.” 
 
Mean-Background 
In addition to the Mean Intensity, we also offer a Mean-Background Intensity, which takes the Mean 
Intensity calculation value one step further and subtracts the mean background value of the image (as 
calculated by the method described above). This value is representative of the signal above the background 
within the ROI. This value was published and described in Slaker et al 2016.  
 
Integrated Density 
Integrated Density is a calculation based on multiplying the Area of an ROI by the Mean intensity value of 
the ROI. Thus, Integrated Density = Area * Mean. ImageJ’s definition of that value can be found here.  
 
Min and Max 
Minimum and maximum gray values within the selection. Min and Max are also ImageJ-based calculations 
called “Min & Max Gray Level.” 
 
Feret’s Diameter 
The longest distance between any two points along the selection boundary, also known as maximum caliper. 
Uses the Feret heading. Feret’s metrics are also ImageJ-based calculations. 
 
Ferets X and Y 
The starting coordinates of the Feret's diameter (FeretX and FeretY) are also displayed.  
 
Ferets Angle 

https://imagej.nih.gov/ij/docs/menus/analyze.html#set
https://www.sciencedirect.com/science/article/pii/S2451830116300139
https://www.sciencedirect.com/science/article/pii/S2451830116300139
https://www.sciencedirect.com/science/article/pii/S2451830116300139
https://www.sciencedirect.com/science/article/pii/S2451830116300139
https://imagej.nih.gov/ij/docs/menus/analyze.html#set
https://imagej.nih.gov/ij/docs/menus/analyze.html#set
https://imagej.nih.gov/ij/docs/menus/analyze.html#set
https://scholar.google.com/scholar?q=A+standardized+and+automated+method+of+perineuronal+net+analysis+using+Wisteria+floribunda+agglutinin+staining+intensity&hl=en&as_sdt=0&as_vis=1&oi=scholart
https://imagej.nih.gov/ij/docs/menus/analyze.html
https://imagej.nih.gov/ij/docs/menus/analyze.html#set
https://imagej.nih.gov/ij/docs/menus/analyze.html#set
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FeretAngle (0-180 degrees) is the angle between the Feret's diameter and a line parallel to the x-axis of the 
image.  
 
Ferets Min 
MinFeret is the minimum caliper diameter.  
 
Circularity 
4π*area/perimeter^2. A value of 1.0 indicates a perfect circle. As the value approaches 0.0, it indicates an 
increasingly elongated shape. Values may not be valid for very small particles. Based on  ImageJ-based 
calculations. 
 
Aspect Ratio 
Major axis/minor axis. Enable "Fit Ellipse" in Analyze>Set Measurements to have the major and minor axis 
displayed. Based on  ImageJ-based calculations. 
 
Roundness 
4*area/(π*major_axis^2), or the inverse of the aspect ratio. Based on  ImageJ-based calculations. 
 
Solidity 
Area/convex area. The Edit>Selection>Convex Hull command makes an area selection convex. Based on  
ImageJ-based calculations. 
 
Skewness 
The third order moment about the mean. The documentation for the ImageJ Moment Calculator plugin 
explains how to interpret spatial moments. Based on  ImageJ-based calculations. 
 
Kurtosis 
The fourth order moment about the mean. Based on  ImageJ-based calculations. 
 
Filename 
Name of the image file (unique if images are named uniquely). 
 
Analysis date 
Date the Analysis Results output file was exported.  

 

Single-Channel Analysis Workflow 
To analyze images with only one channel/biomarker, see the workflow outlined below. For multi-channel images 
and colocalization analysis see the Colocalization Analysis Workflow. 
 

1. Go to the projects tab and create a new project with a description of your experimental details.  
 

2. Import image files into your new project. Delete and rename as needed by right-clicking the image or 
folder. You can drag images and whole folders into existing folders to create subfolders to further 
organize your images. Images are stored locally and tied to their original location on your computer. 

 
3. Click on an image in the left side Projects panel to bring it up as the active image in the center window. 

This is the only image that will be affected by the settings in the right-side Analysis panel. 
 

4. Select an appropriate detection model from the pull-down menu in the top right-side window. Don’t 

https://imagej.nih.gov/ij/docs/menus/analyze.html#set
https://imagej.nih.gov/ij/docs/menus/analyze.html#set
https://imagej.nih.gov/ij/docs/menus/analyze.html#set
https://imagej.nih.gov/ij/docs/menus/analyze.html#set
https://imagej.nih.gov/ij/docs/menus/analyze.html#set
http://rsb.info.nih.gov/ij/plugins/moments.html
https://imagej.nih.gov/ij/docs/menus/analyze.html#set
https://imagej.nih.gov/ij/docs/menus/analyze.html#set
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know what model to choose? If your cell or biomarker of interest isn’t in the list, choose one that most 
closely resembles your marker from the General Models list. Try this with different models until you get 
one that works best or try our “Recommend Model” feature in the model drop-down list. Selecting more 
than one image will improve the recommendation quality. To select multiple images, press Shift or 
Control (Command on MacOS) and select images in the Project panel. Then, right-click on the highlighted 
image names and select Recommend Model. The model won’t be perfect because it wasn’t trained on 
your images, but you can manually fix errors in the next step.  
 

5. Once you’ve selected a model, click Detect Cells and wait a moment to see the detected ROIs appear on 
your image. Try different image settings until you get the best detection. See the Analysis Settings 
section above for more information on what the settings do. 
 

6. You can click to select an ROI on the image and delete or resize the ROI by clicking and dragging the 
edges. Click and drag with your mouse to add new ROIs, which will be automatically added to the ROI 
list with the “FFF” prefix on the ROI ID. You can even change the color of the ROI box under options. 
 

7. After you’re satisfied with your dataset, click “Approve ROIs” which will add a checkmark next to that 
image in the Project panel and add it to your data output file. 
 

8. When you’re done analyzing all of your images, click “Export Results” to export your data to an Analysis 
Results output “.csv” file.  

 
Didn’t find a good detection model or settings for your images? Add your annotated images to a custom 
detection model. Check out our Custom Model Training tutorial in Polygon and the Custom Model Training 
section below. 
 

Advanced Analysis Settings 

Image View Settings 
These settings only adjust the way you view the image to assist in visualizing your biomarkers or cells. They do 
not change the way the detection model functions or affect image quantification in the Analysis Results output. 
 

Brightness and Contrast Adjustments  
You can adjust the brightness and contrast of the active image to bring out weaker signals. 
 
MinMax Pixel Adjustment  
These settings allow you to set the minimum and maximum intensity values in the active image. Raising the 
Min + lowering the Max can work better than brightness/contrast to accentuate the middle ground. Raising 
the Min level can also help remove some background noise. 
 
LUT Operation  
False color grayscale images to suit your preference. Useful for visualizing differences in pixel intensities 
with different colors. 

Image Analysis Settings 
These settings will affect the detection model results and your resulting data output! 
 

Area Selection  
This allows you to analyze only a selected subregion(s) of your image. Draw an area(s) to include using the 
square, circle, or polygon drawing tools.  
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Area Exclusion  
This allows you to exclude a selected subregion(s) of your image. Draw an area(s) to exclude using the 
square, circle, or polygon drawing tools.  
 
Unit Scale 
The size of the image and the physical scale are properties that won’t directly affect the cell detection or 
intensity measurement. However, some labs choose to report cell intensity as mean intensity/area, in which 
case you would need to double check the area calculation. If pixel scale information is not provided, metrics 
such as area will be returned in pixels rather than physical distance. Calculate your scale from your 
microscope software or using a scale bar watermark on images exported from your microscope. 
 
Invert Image  
Creates a reversed image, similar to a photographic negative, of the entire image or selection. Pixel 
intensities remain relative to non-inverted values and can be used for quantification. This tool is useful for 
detecting cells/targets stained with immunohistochemical methods (dark staining on a bright background) 
using Detection Models trained on fluorescent stains (bright staining on a dark background) and vice versa.  

 
Multi-channel and Colocalization Analysis 
 
Colocalization mode allows users to analyze multiple biomarkers in an image via split channels and assess the 
number and degree of colocalization. 

Types of Colocalization Analysis: 
1. Object-Based: This is best for objects that overlap a majority of their area, such as a nuclear marker 

within a cell body marker. This method uses the Minimum Overlap Percentage value to define area 
overlap sufficient for colocalization. 

2. Adjacent Objects: This is best for assessing the colocalization of distinct objects that are in proximity to 
each other.  

3. Multiple Objects Within: This option is for users that have multiple smaller objects within a larger object. 
You will need to specify the channel with the larger object as the “Marker Image”. This method uses the 
Minimum Overlap Percentage value to define area overlap sufficient for colocalization. 

 

Colocalization Analysis Workflow 
1. To colocalize images, either select a folder or the relevant individual images with ctrl- or shift-click, then 

right-click and select "Colocalize." 
  

2. If you do not have a merged image: Set the Image Color Channels to the colors you want for each image 
and click the "Create Merged Image" button. A new merged image should appear in the middle window 
alongside the original images. 
 

3. If you have your own merged image, you can select it alongside the single-channel images in step 1 and 
set the detection model in the drop-down menu for that image to “Merged/None.” 
 

4. If you haven’t yet run detection and annotated your images: Once you've finished adding and editing 
your annotations, click "Run Colocalization" and the overlapping ROIs will appear on the merged image. 
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5. You can then "Export Results". The export parameters will be the same as for Single-Channel analysis as 
described in the Export Parameters section, but unique to Colocalization are columns indicating which 
ROIs colocalized with others. 

 
 

Custom Model Training 

When and Why to Train a Custom Model 
A custom detection model allows you to train your own unique model to detect your biomarker of interest. If 
none of our existing detection models worked well for your images, then this may be a good option for you. 
With relatively small upfront effort, you can create a model that will dramatically reduce your analysis time 
while improving the consistency of your results. See the Custom Model tutorial under the Help menu within 
Polygon AI or keep reading for more information. 

Training a Custom Model 
When setting up a new custom model, please provide a brief but descriptive name for your unique model. This 
will be displayed in the community models list if you decide to publicly share your model. We recommend 
including your lab or last name and an abbreviated biomarker or cell type name. A more detailed description 
about your experiment and image dataset will also be helpful for future users and allow you to differentiate 
between multiple custom models more easily. Private models can also be shared between users with Premium 
licenses: either add the account email address(es) when first creating a new model, or right-click an existing 
model and select Edit. You can then add emails in the Shared User window and press Add User.  
 
To get started with the custom model training process, you’ll need to annotate at least 5 images but more is 
always better (see the Single-Label Analysis Workflow above). It is important to annotate all the objects of 
interest on each image, and each ROI should have its corresponding object fully within it. See our associated 
blog post for annotation best practices. After annotating and approving the training images, you can add the 
image set to a custom model. From here you will be prompted to provide detailed contours for at least 20 
random objects (again, more is better) in the 5 training images. Once you reach these minimums, use the 
“Submit” button to start the training process.  
 
If you are training a segmentation model with masks, all your annotations will be automatically converted to 
contours during custom model training.  
 
After submitting your custom model for training, we’ll get back to you as soon as a few hours, but no more than 
a few business days with a new custom model to test and refine as needed. 

Testing and Improving Custom Models  
Once the model is done training it will appear in the model drop down menu. Test it on images of the same type 
of objects, but that you did NOT use for training. You can submit more annotated images and contours as 
needed to improve the detection quality. 

Custom Model Training Workflow 
1. After fully annotating an image, click “Approve ROIs”, which will add a checkmark next to that image in 

the Project panel file tree. Only approved images will appear in the Custom Model Training submission 
window. Repeat for several images – we recommend a minimum of 5 images with at least 500 
annotations. Important: each training image must all be the same single biomarker. Multi-channel 
images must be split into single channels prior to annotation and training.  

2. Create a new model in the Custom Model tab by clicking the “Create Model” button.  

https://medium.com/@rewireneuro/machine-learning-isnt-magic-b7d06cf9b305


14 
 

3. Give your model a unique name. We recommend at least Lab/Company name + Biomarker, e.g. “My 
Awesome Rewire Parvalbumin model”. In the Model Description box, you can provide additional details 
about the experiment to distinguish between future models. This information will also be useful to other 
users if you choose to share your model publicly.  

4. Private models can be shared between users with Premium licenses by adding the account email 
address(es) in the Shared User window and pressing Add User.  

5. Choose the Project that contains your annotated training images. 

6. Select your new model from the custom model list and click “Add Images” 

7. All Approved images in the Project will be automatically selected. Deselect any images you don’t want to 
include in the training dataset and click “Add”.  

8. Once the blue progress bar fills up, indicating you have enough images and annotations, click “Train 
Model” and click “Train” to submit. We’ll contact you within a few business days to let you know your 
model is ready. Once deployed, your custom model will appear in the model drop down list.  

Other Features 

ROI Table  
This shows a list of the ROIs drawn on the active image, with the corresponding X,Y coordinates in the image as 
well as the size of the ROI box in pixels. IDs contain number prefixes for ROIs detected by the model and letter 
prefixes for ROIs added manually by the user. Hovering over an ROI in the table will highlight the corresponding 
ROI box in the active image. Conversely, hovering over an ROI in the image will move to the corresponding ROI 
in the table. ROIs with a blue checkmark will be included in the final data export. ROIs that are manually deleted 
from the image will automatically disappear from the ROI table. 

ROI Filtering 
We now offer several ROI filtering options in the ROI Filter tab on the right-hand analysis menu.  

Z-stack Analysis 
See the Importing Images section for detailed information about importing z-stacks. After import, you can view 
your stacks as summed or max projected images. 3D Trace allows detection of individual objects through layers. 
Premium users can right-click a stack and select Batch Detection to run analysis on all images in the stack. 
Exporting Analysis Results from different z-stack views (summed, max projection, or 3D trace) results in identical 
Analysis Results output files. See Export Parameters above for more information on Analysis Results output 
column variables and column variables specific to z-stacks.  
Note: You cannot yet use colocalization in stacks 

Batch Detection 
This Premium License feature allows users to speed up their workflows by successively analyzing multiple 
images in sequence and outputting their data in aggregate for a given experimental folder. To perform Batch 
Processing, select multiple images in the Project panel, then right-click > Batch Detection. Images will open as a 
grid in the center window. Begin by selecting a single Detection Model and Detection Settings to apply to all 
images, then click Detect Cells. Images will process in parallel and display a checkmark in the Project panel when 
complete. ROIs can then be checked and edited for accuracy, and then marked Accepted for Export. See Export 
Results section for detail on batch export. It is also possible to use Batch Detection across layers in a Z-Stack. 

Touch-screen Mode 
Polygon AI is compatible with touch screen computers running Windows or MacOS. Unfortunately, at this time it 
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cannot run on Google Chrome tablets or smartphones. For best performance we recommend using a mouse, but 
it is possible to draw ROIs with a finger or stylus. You can also double-tap to add ROIs. 
Touch screen compatibility is automatically available on any touch device, with no need to turn on any mode or 
settings.  
 

Account & License Options 

Licenses 
The basic free license limits a user to 2GB of image storage and 2 custom models at a time. Your count towards 
these limits will appear in the bottom right corner of the app. You can test out the Premium license features 
under the Polygon Demo Project that automatically loads with your installation. This gives you ample time to 
test it out before you decide if a full-featured 1 year license is right for you.  
 

Set-up Multi-factor Authentication 
For those who use an authenticator app, you can turn on 2FA from the Account window. 
 

Hotkeys 
We provide several useful Hotkeys to streamline your analysis, as shown below. Also see the list under Help > 
Hotkeys in the Polygon AI app.  
 
● Hide/unhide all ROIs on an active image: ctrl + t 
● Remove ROIs on an active image (as well as from the ROI list): Delete or Backspace 
● Collapse the left window: ctrl + < 
● Expand the left window: shift + ctrl + < 
● Collapse the right window: ctrl + > 
● Expand the right window: shift + ctrl + > 
● Reset zoom to original size: ctrl – 
● Zoom with mouse scroll wheel: hold ctrl + scroll 
● Pan around image with mouse: hold ctrl + click & drag image 

Suggestions for additional useful Hotkeys or features? Let us know with the feedback suggestion window, 
accessed from the help “?” icon in the lower right corner of the app. 
 

Support & Troubleshooting 
We offer a wide variety of support documents, including this comprehensive instruction document. See our Help 
& FAQ webpage for frequently asked questions, trouble-shooting tips, and links to video tutorials (coming soon). 
Free license users can refer to the above material for assistance. You can also report a bug or provide feedback 
with the “?” icon in the lower right corner of the app. Premium users will have access to email support (replies 
within 48 business hours) and up to 1 hour of Zoom lab training per paid license year. Additional live video 
training may be purchased as an add-on as needed. We also encourage users to attend our webinars for 
demonstrations of features and live Q&A sessions. Sign up for our email newsletter and social media accounts to 
stay informed of upcoming webinars. 
 

eLabNext Plug-in 
eLabNext digital lab notebook users can take advantage of our Polygon plug-in to easily add images and results 
from their analysis into eLab. You must first log in with your eLab credentials via the eLab tab. 

 

https://rewire.ai/help/
https://rewire.ai/help/
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